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Typographic Conventions

Type Style ‘ Description

Example Words or characters quoted from the screen. These include field names, screen titles, pushbuttons
labels, menu names, menu paths, and menu options.

Textual cross-references to other documents.

Example Emphasized words or expressions.

EXAMPLE Technical names of system objects. These include report names, program names, transaction codes,
table names, and key concepts of a programming language when they are surrounded by body text,
for example, SELECT and INCLUDE.

Example Output on the screen. This includes file and directory names and their paths, messages, names of
variables and parameters, source text, and names of installation, upgrade and database tools.

Example Exact user entry. These are words or characters that you enter in the system exactly as they appear in
the documentation.

<Example> Variable user entry. Angle brackets indicate that you replace these words and characters with
appropriate entries to make entries in the system.
EXAMPLE Keys on the keyboard, for example, or ENTER].
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1 What's New in This Document

This section highlights the main changes in this user assistance. They relate both to new or changed features in the software

deliveries of SAP Convergent Charging 2025 and to documentation enhancements for enriching your SAP user experience
continuously.

1.1 What's New in FPS O

As of FPS 0:

e Minor documentation change: SAP CC 2025 is a new major release. The new chapter Related Documentation contains links

to SAP Billing and Revenue Innovation Management (BRIM) on SAP Help Portal.
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2 Introduction

SAP Convergent Invoicing in SAP ERP provides a feature about consumption item storage. This guide describes the procedure to
be applied in SAP Convergent Charging and in SAP Convergent Invoicing to enable the support of consumption item storage of
SAP Convergent Invoicing by SAP Convergent Charging.

2.1 Target Audience

This guide is for implementation project teams and administrators who already have a working platform including SAP
Convergent Charging and SAP Convergent Invoicing and who want to know how to upgrade it to benefit from the features of
consumption item storage. In this context, upgrading means to move from an SAP system landscape where SAP Convergent
Charging rates or rerates chargeable items to a landscape where SAP Convergent Charging rates chargeable items and SAP
Convergent Invoicing rates and rerates high volumes of chargeable items. In both landscapes, BART Server is still involved in the
rating of chargeable items.

1 Note

The support of the consumption item storage by SAP Convergent Charging for a new implementation project is
already described in other documentation, and therefore it is out of scope of this guide.

2.2 About This Document

This guide is structured into nine sections. After the overview in Section 2 and the enumeration of the constraints and
limitations regarding the transition in Section 3, the remaining sections explain the different actions needed for successful
enablement of the support of consumption item storage. Section 9 gives you additional information about some procedures.

2.3 Before You Start

The consumption item storage feature of SAP Convergent Invoicing stores a high volume of consumption items. A consumption
item is the record of the consumption of a service by an end consumer (often called consumption detail record in
telecommunication industry). The consumption item represents the transactional data for three main business scenarios:

e Cl Triggered Rating
e Manual Capturing
e Rerating

When SAP Convergent Invoicing is integrated with SAP Convergent Charging, a consumption item is a chargeable item
consolidated with the information related to an end customer, such as the provider contract of the consumer; for example. SAP
Convergent Charging can charge a consumption item converted into a chargeable item, and this charging operation may
generate billable items.
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This technical guide assumes that the reader already knows the concepts of consumption items, chargeable items, and the
different business scenarios related to this transactional data.

For more information about these scenarios, see the SAP CC Application Help documentation.
Furthermore, the reader must be familiar with the following tasks to execute the migration procedure:

e The start, stop, or restart of the instances of the SAP CC systems (see the section Starting and Stopping the Server Systems
in the SAP CC Installation Guide)

e The change of the instance configuration parameters (see the primary help for the Cockpit and Admin+ user interfaces)

e The synchronization of the chargeable item classes and consumption item classes (see the section Managing and
Maintaining SAP CC in the SAP CC Application Help)

2.3.1 Terms and Acronyms

Term Acronym Definition
Batch Acquisition and Rating BART Component dedicated to the CDR offline acquisition and to the
Toolset batch charging of converted CDRs. These processes define

together the Rating business scenario. If not mentioned, the
acronym 'BART' stands for BART Server or BART database
depending on the context.

Consumption Detail Record CDR Chargeable items in SAP Convergent Charging or consumption
items in SAP Convergent Invoicing

Charging output Integration CIF The Charged item Integration Framework (versions of SAP

Framework Convergent Charging earlier than 4.0) is enhanced to support
the process of chargeable items output by SAP CC rater
instances. From version 4.0 onwards, this framework keeps the
same acronym but is named Charging output Integration
Framework (CIF).

Enhancement Package EhP
SAP Convergent Invoicing SAP Cl
SAP Convergent Charging SAP CC

2.4 Related Documentation

SAP Convergent Charging
You can find the SAP CC 20253 product documentation on SAP Help Portal at: https://help.sap.com/cc.

SAP Convergent Invoicing
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https://help.sap.com/cc

You can find the documentation about SAP Convergent Invoicing at: https://help.sap.com/erp608 > Application Help > SAP

Library > Industries in SAP ERP > SAP for Telecommunications > Contract Accounts Receivable and Payable > SAP Convergent
Invoicing.

SAP BRIM Using SAP ERP

You can find the integration guides and the migration guides of SAP Billing and Revenue Innovation Management (BRIM) on
SAP Help Portal at: https://help.sap.com/brim.
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3 Transition Overview

The starting point of this transition is a working landscape including SAP Convergent Charging systems (BART Server and Core
Server) and SAP Convergent Invoicing (in the ERP system) as shown in the following illustration:

Acquired Charged ]
Chargeable Chargeable Bllltlear?e
[tem ltem

> >
SAPCC C SAPCC O
BART Server Core Server SAPCI

V4.0 Ehp7

Figure 1: Working Landscape

In this production SAP system landscape, SAP Convergent Charging is the master component of the rerating process, and the
BART Server system of SAP Convergent Charging executes the rerating process. The BART Server system only processes
chargeable items stored in its database (acquired and charged chargeable items). When the Core Server system charges
chargeable Items, it generates charged items that are loaded as billable items into SAP Convergent Invoicing for the invoicing
process.

The principle of this transition consists in filling SAP Convergent Invoicing in SAP ERP with consumption items for enabling the
rerating process provided by SAP Convergent Invoicing. This is done in three phases as shown in the following timeline:
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Phase 1 Phase 2 Phase 3

Preparation Switch Termination
Create Consumption ~ Enable Consumpfion ltem Switch from BART to the
ltem Class/Mapping Loading Data Storage of SAP ClI

Check the Chargeable items
are loaded into SAP Cl

- I I I I >
d1 d2 d3 d4

(d1+nweeks) (d2+1to2weeks) (d3 + one retention period of CDR rerating)

Dates (d1, d2. d3, d4)

Transition Phase
[ Active phase

[ Validation phase SAP CC_|DEIdS
Consumption ltems
into SAP ClI

Figure 2: Transition Timeline

This timeline shows the active and validation phases:

e An active phase is a period during which the administrator must perform actions on the system landscape to enable or
configure the required features.

e The validation phase is a period during which the administrator must check, and then validate, that the actions previously
performed work perfectly.

3.1 Phase 1: Preparation

During phase 1, the administrator prepares the transition phase:

e The chargeable item packages are removed. The chargeable item classes of these packages will exist as independent
objects.

e The consumption item classes related to the already existing chargeable item class are created in SAP Convergent
Invoicing, and then synchronized in SAP Convergent Charging.

1 Note

This guide describes a complete transition meaning that each chargeable item class of the SAP CC system must have
its related consumption item class in the SAP Cl system and will generate consumption items. If a chargeable item

class is not mapped onto a consumption item class, the SAP CC system will reject the charging and acquisition of the
chargeable items of this class.

The duration of phase 1 depends on the number of chargeable item classes to be synchronized with consumption item classes.
You need to plan several weeks to complete phase 1 successfully.
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3.2 Phase 2: Switch

The goal of phase 2 is to enable SAP Convergent Charging for loading consumption items into SAP Convergent Invoicing. The
working landscape is shown in the following figure where the thick arrow means that SAP Convergent Invoicing handles
consumption items:

Acquired Charged . .
Chargeable Chargeable Bllltlsr?e Consltl.é:nﬂptmn
ltem ltem
L

SAPCC C SAPCC C
BART Server Core Server SAPCI

V4.0 Ehp?

Figure 3: Phase 2, Switch

According to Figure 3, SAP Convergent Invoicing writes consumption items to its database but does not work with consumption
items, except when SAP Convergent Invoicing removes the consumption items corresponding to reversed billable items during
a rerating operation.

In Figure 3, SAP Convergent Charging performs the rerating. Chargeable items (CDRs) are stored in BART while consumption
items are stored twice:

e In SAP Convergent Charging when the BART Server system charges or recharges chargeable items

e In SAP Convergent Invoicing for preparing and handling the future rerating process

The duration of phase 2 is estimated at one or two weeks. The administrator first has to configure SAP Convergent Charging (<
4 hours), to check that the consumption items are successfully loaded into SAP Convergent Invoicing, and to fix the issues which
can occur. At the end of phase 2, the working landscape is well configured and the transition phase can start.

3.3 Transition Phase

During the transition phase, the chargeable items (converted into consumption items) are successfully loaded into SAP
Convergent Invoicing. The duration of the transition phase is at least one CDR retention period, that is, the maximum duration
(usually several months) to keep consumption items for rerating purposes.
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3.4 Phase 3: Termination

After the transition phase, SAP Convergent Invoicing contains enough consumption items to support the rerating process. The
working landscape is configured so that SAP Convergent Invoicing performs the rerating process (the rerating process is
deactivated in SAP Convergent Charging):

Acquired - -
Chargeable Blllllsl'%le ConTtLéTnptlon
ltem
®

SAPCC 3 SAPCC C
BART Server Core Server SAP CI

V4.0 Ehp7?

Figure 4: Phase 3

In Figure 4, SAP Convergent Invoicing handles and processes consumption items.

3.5 Prerequisites, Limitations, and Warnings About the Procedure

Keep in mind the following:
e Consumption item management is only available for provider contract-based business.

o Subscription-based business is not supported, and system landscapes must keep BART in SAP Convergent Charging (no
transition is possible).

o Subscription and provider contract-based business are not supported together, and system landscapes must keep
BART in SAP Convergent Charging (no transition is possible).

e Only monocatalog-based business can be integrated with SAP Convergent Invoicing (one service provider for rerating
operations)

e We recommend testing the procedures first in a test landscape.

e After the transition, the generator of provider contract locks changes from SAP Convergent Charging to SAP Convergent
Invoicing. A lock code already used by SAP Convergent Charging can be computed again by SAP Convergent Invoicing even
if this probability is very low. Therefore, if the provider contracts are searched in SAP Convergent Charging from a lock
code computed by SAP Convergent Invoicing, some provider contracts are included even if they were not rerated by SAP
Convergent Invoicing.

e The rerating operation in SAP Convergent Invoicing is available after the complete retention period of chargeable items for
rerating purposes (after 40 to 180 days). It is also the case for Cl triggered rating and manual capturing. We recommend
that you plan enough time to execute this transition phase.
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14

SAP Convergent Charging will generate chargeable items that it will convert into consumption items saved in temporary
files. The hard disk of the system landscape must be enhanced to support the creation of new files (about several
megabytes).

SAP Convergent Invoicing uses a technical SAP CC user for the rating and rerating processes. SAP Convergent Invoicing also
uses the same SAP CC user for the replication process of provider contracts.
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4 About the Procedure

You must apply the procedure in three phases (phase 1, phase 2, and phase 3). It is strongly recommended that you apply the
procedure to the test landscape, and then transport the different configurations to the production landscape.

You must execute the steps of the procedure according to the following sequences:

? o

| step7 | | Steps |
h! | l’Ll [ L) »
St el
d1 d2 d3
(d1+nweeks) (d2+1to2weeks) (d3 + one retention period of CDR rerating)

Figure 5: Sequences of steps

Note: You can execute step 5 and step 6 sequentially in one of the following ways:
e Forall the chargeable item classes at one time (first step 5, and then step 6)

e  For each chargeable item class, chargeable item class by chargeable item class (step 5, step 6, step 5, step 6, and so on)

The overall procedure consists of the following steps:

Phase 1: Preparation

e Step 1 (SAP CC): Remove the links between chargeable item packages and chargeable item classes

e Step 2 (SAP CC): Enable the synchronization of consumption item classes

e Step 3 (SAP Cl): Activate the ‘Link with Consumption Items’ interface component for billable item classes

e Step 4 (SAP CC): Update the billable item mapping
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e Step 5 (SAP Cl): Create a consumption item class for each existing chargeable item class

e Step 6 (SAP CC): Synchronize the chargeable item classes of SAP CC with the consumption item classes of SAP Cl
Phase 2: Switch

e Step 7 (SAP CC): Enable the loading of consumption items to SAP Cl in SAP ERP

Phase: Transition

e Step 8 (SAP Cl): Customizing for the transition phase

Phase 3: Termination

e Step 9 (SAP CC): Start the charging/recharging Web service

e Step 10 (SAP Cl): Create an SAP Convergent Charging logical port for the Web Service Consumer Proxy
e Step 11 (SAP Cl): Customizing for phase 3

e Step 12 (SAP CC): Enable SAP CC to support the rerating process of SAP Cl

e Step 13 (SAP CC): Enable the archiving of CDRs in BART Server

e Step 14 (SAP CC): Extend the retention period of counter snapshots for high-volume management purposes

Conventions for describing a procedure step

Each step is described in a table as follows:

Step Identifier

When The time at which the step must be performed

Who The required role or the permission of the agent who performs the step

How The tool to perform the step

Before the The list of actions that the agent must perform before performing the step

Task

Task A short description of the step

Step The list of actions that the agent must perform during the step

After the Task | The list of actions that the agent must perform to check that the step is successful

In this procedure, it is assumed that the SAP Convergent Charging installation tool (SAPInst) has installed a dispatcher instance
in the INST_DIR directory.

The INST_DIR path may look like this: ...\usr\sap\<SID>\CCD## where:
e SID: Is the SAP System ID of the SAP Convergent Charging system
e H#:1sanumber

If several directories match the INST_DIR pattern, use the one having the lowest ##.

It is also assumed that the SAP Convergent Charging installer has installed its shared file repository in the directory ‘REPO_DIR’.
The REPO_DIR path may look like this: ‘...\usr\sap\<SID>\SYS\exe\uc\<PLATFORM>" where:

e SID: Is the SAP System ID of the SAP Convergent Charging system
e PLATFORM: Is a platform-specific folder
The path shortcut <REPO_CONFIG_DIR> is the shortcut for the directory ‘<REPO_DIR>/CC_CORE_SERVER/config/sapci/’.
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For this procedure, the required SAP Convergent Charging tools are available in the ‘INST_DIR/script/’ of a dispatcher instance.

The scripts 'setup’, 'config' and 'admin+' launch the tools 'Setup Tool', 'Config Tool', and 'Admin+' respectively.
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5 Procedure Checklist

Before starting the procedure, check that:

e The version of SAP Convergent Charging is at least SAP Convergent Charging 4.0 or above. If this is not the case, upgrade to
the latest SAP Convergent Charging version. For more information about how to upgrade SAP Convergent Charging, see
the related documentation (SAP CC Upgrade Guide). See section 9.2 for how to check the software component version of
SAP Convergent Charging that is running. The technical version number must be equal or greater than 4.5.0.0.

e The version of SAP Convergent Invoicing is at least SAP ERP EhP7 or above. If this is not the case, upgrade to the latest SAP
Convergent Invoicing enhancement package. For more information about how to upgrade SAP Convergent Invoicing and
SAP ERP, see the related documentation.

The systems to be updated fulfill the prerequisites defined in section 2.5.
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6 Procedure - Phase 1

6.1  Steps of Phase 1

6.1.1 Step 1 - SAP CC

SAP Convergent Charging executes this step.

Remove the Links Between Chargeable Item Packages and Chargeable Item Classes

When During the preparation phase, but before the synchronization of the chargeable item classes with the
consumption item classes between SAP Convergent Charging and SAP Convergent Invoicing.

Note: Because this step requires restarting the instances, it is strongly recommended to execute this
step when the workload of the SAP Convergent Charging Server instances is the lowest.

Who Administrator

How Setup Tool

Before the N/A

Task

Task Remove the references to the chargeable item packages of chargeable item classes. This ensures that
the identifiers of the chargeable item classes are unique between all the chargeable item classes of
the system.

Step 1. Generate the chargeable item package migration report.

a) Execute the command with the Setup Tool user interface:
setup migration generateCIPackageReport
./chargeableItemPackageMigrationReport.xml

b) Enter your login and password at the prompt.
c) Check on the console that the report has been successfully exported.

Note: If the report cannot be exported because some invalid charge components have been
found, first fix the listed charge components, and start the generation of the report again.

2. Open the report with a text editor (an XML editor is recommended) and, as described in the
header of the XML file, provide the name of the new chargeable item classes when requested.

3. Save your changes.
4. Stop the updater instances of the SAP CC system.
5. Execute the report.

a) Execute the command:

setup migration executeCIPackageReport

./chargeableItemPackageMigrationReport .xml
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I EEE—
Remove the Links Between Chargeable Item Packages and Chargeable Item Classes

b) Enter your login and your password at the prompt.
c) Check on the console that the report has been successfully executed.

Note: If the report cannot be executed, read the error message displayed on the console,
try to fix the problem, and then execute again the report.

6. If you have NOT planned to execute the next step right now, apply the configuration by
restarting the Updater instances.

After the Task | N/A

6.1.2 Step 2 - SAP CC

SAP Convergent Charging executes this step.

Enable the Synchronization of Consumption Item Classes

When After step 1 is successfully executed.

Note: Because this step requires restarting the instances, it is strongly recommended to execute this
step when the workload of the SAP Convergent Charging instances is the lowest.

Who Administrator

How Admin+, Setup Tool, and Core Tool (only for validation)

Before the Open the SAP Convergent Charging Core Tool user interface, and then check that the menu “File >
Task New > Consumption Item Mapping” is not available; otherwise, skip this step.

Task The goal of this step is to configure SAP Convergent Charging for enabling the consumption item class

synchronization from SAP Convergent Invoicing to SAP Convergent Charging.

Note: During this step, you make a backup of the configuration parameter that the procedure of
recovery (section 6.3) can reuse later.

Step 1. Import the up-to-date, default billable item mapping into SAP Convergent Charging.
a) Execute the command with the Setup Tool user interface:

setup sapci importDefaultMapping chargedItem
<REPO_CONFIG DIR>/sapci cit defaultMapping.xml.sk

b) Enter your login and password at the prompt.
c) Check on the console that the import is successful.

2. Export the administration parameters of the updater to a file.
a) Execute the command with the Config Tool user interface:

config configuration export
sapccUpdaterInstanceParameters phasel.xml updater

b) Enter your login and your password.

Note: The configuration parameters of the updater instances are written in the XML file
named “sapccUpdaterinstanceParameters_phasel.xml” which is stored in the directory
where Config Tool was launched.

Public
© 2025 SAP SE or an SAP affiliate company. All rights Activation of Consumption Item Management in SAP Convergent Charging and SAP Convergent Invoicing
20 reserved. Procedure - Phase 1



Enable the Synchronization of Consumption Item Classes

c) Check that the file sapccUpdaterinstanceParameters_phasel.xml exists, you can open it
in a text editor, and it is not empty.

3. If the Admin+ user interface is not yet connected to a dispatcher, connect Admin+ with the
dispatcher instance according to the steps defined in section 9.1.

4. Check that the SAP Convergent Charging configuration regarding the charged items is correct.
a) Execute the command:
get EIF EXTERNAL SYSTEM CODE CHARGED ITEM persistent updater
b) Check that the persistent value is ‘Cl" as shown in the following snapshot:
Received from updater#l
- NAME: EIF_EXTERNAL_SYSTEM_CODE_CHARGED_ITEM (PERSISTENT, updater)
- ACCESS: read-write (DB)
- DEFAULT VALUE: None
- PERSISTENT VALUE: CI

Note: If the persistent value is not ‘Cl’, the current system configuration is not compliant
with this procedure.

5. Configure SAP Convergent Charging to enable the consumption item class synchronization.
a) Execute the command:
set EIF EXTERNAL SYSTEM CODE CHARGEABLE ITEM CI persistent

b) Check that the value of the EIF_EXTERNAL_SYSTEM_CODE_CHARGEABLE_ITEM now has
a persistent value set to ‘Cl" as shown in the following snapshot:

Received from updater#l
- NAME: EIF_EXTERNAL_SYSTEM_CODE_CHARGEABLE_ITEM (PERSISTENT, updater)
- ACCESS: read-write (DB)
- DEFAULT VALUE: None
- PERSISTENT VALUE: CI
6. Import the default additional chargeable item fields.
a) Execute the command:

setup sapci importDefaultMapping chargeableltem
<REPO_DIR>/CC_CORE_SERVER/config/standalone/sapcc_ci additiona
1Fields.xml.sk

b) Enter your login and your password at the prompt.

Note: Check on the console that the default mapping for the type ‘chargeable item’ and the
system code ‘CC’ is successfully imported.

7. Import the default field mapping for the chargeable items.
a) Execute the command:

setup sapci importDefaultMapping chargeableltem
<REPO_CONFIG DIR>/cit ci/sapci ci defaultMapping.xml.sk

b) Enter your login and your password at the prompt.

c) Check on the console that the default mapping for the type ‘chargeable item’ and the
system code ‘Cl’ is successfully imported.

8. Apply the configuration:
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Enable the Synchronization of Consumption Item Classes

o Restart the Updater instances of SAP Convergent Charging.

o If some instances of the Core Tool are running, you must restart them to take this
configuration change into account.

After the Task | Launch the SAP CC Core Tool user interface and check that the menu “File > New > Consumption Item
Mapping” is now available.

6.1.3 Step 3 - SAP CI

SAP Convergent Invoicing executes this step.

Activate the ‘Link with Consumption Items’ Interface Component for Billable Item Classes

When When the transition project starts.

Who N/A

How SAP GUI

Before the N/A

Task

Task For each billable item class whose ‘SAP Convergent Charging’ interface component is activated,

activate the ‘Link with Consumption Items’ interface component, and regenerate the tables. This
additional, activated interface component enables navigation between the consumption items and
billable items and vice versa through the display functions.

Step 1. In SAP GUI, execute transaction spro.
2. Click the ‘SAP Reference IMG’ button.
3. On the ‘Display IMG’ screen, open the activity:

Financial Accounting > Contract Accounts Receivable And Payable > Convergent Invoicing > Basic
Functions > Billable Item Classes > Maintain Billable Item Classes

4. See the related documentation for how to add an interface component to a billable item
class.

5. Select your billable item class, select Change mode, and then select Choose Interface
Components (F7).

6. Add the ‘Link with Consumption Items’ interface component to the billable item classes

where the interface component ‘SAP Convergent Charging’ is activated.

7. Activate your modified billable item configuration and regenerate (next activity in IMG) your
modified billable item classes.

After the Task | N/A
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6.1.4

Step 4 - SAP CC

SAP Convergent Charging executes this step.

Update the Billable ltem Mapping

When After step 3
Who Administrator
How Core Tool
Before the N/A
Task
Task The goal of this step is to update the billable item mapping in SAP Convergent Charging to take into
account the ‘Link to Consumption Item’ interface component added previously in the billable item
classes.
Step In the Core Tool user interface:
1. Open each billable item mapping.
2. Refresh the billable item mapping.
3. Save the billable item mapping.
After the Task | N/A

6.1.5

Step 5 - SAP CI

SAP Convergent Invoicing executes this step.

Create a Consumption Item Class for Each Existing Chargeable Item Class

When When the transition project starts.

Who N/A

How SAP GUI

Before the N/A

Task

Task For each chargeable item class defined in SAP Convergent Charging, create the related consumption
item class, the consumption item class proxy, and the consumption item class custom mapping.
You can execute this step chargeable item class by chargeable item class.

Step In the SAP GUI, for each chargeable item class, and for each chargeable item user field:

1. Choose the data element of the field.
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Create a Consumption Item Class for Each Existing Chargeable Item Class

Note: Among the available data elements, choose the one that is compliant with the
semantic and the technical type of the field. If no data element is compliant, create a new
data element for the field.

a) Choose the domain of the data element:

o Among the available domains, choose the one that is compliant with the semantic and
the technical type of the field.

o If no domain is compliant, create a domain for the data element.
2. Add a consumption item field in the Customizing Include if it does not already exists.

Note: For more information on how you can name a consumption item field, see section
9.4.1.

3. Create the consumption item class.

Note: Do not generate the consumption item tables or functions. For more information on
how you can name a consumption item class, see section 9.4.2.

4. Configure the custom mapping.

5. Generate the consumption item tables or functions

After the Task | N/A

6.1.6 Step 6 - SAP CC

SAP Convergent Charging executes this step.

Synchronize the Chargeable Item Classes of SAP CC with the Consumption Item Classes of SAP CI

When When step 5 is successfully executed for at least one consumption item class synchronized with a
chargeable item class.

Who Administrator

How Core Tool

Before the Step 2 is successfully executed for all the chargeable item classes existing in SAP Convergent

Task Charging.

Task Synchronize all the chargeable item classes of SAP Convergent Charging with the consumption item

classes of SAP Convergent Invoicing.

Note: This guide describes a complete transition meaning that each chargeable item class of the SAP
CC system must have its related consumption item class in the SAP ClI system and will generate
consumption items. If a chargeable item class is not mapped onto a consumption item class, the SAP
CC system will reject the charging and acquisition of the chargeable items of this class.

Step See the documentation of SAP Convergent Charging about the synchronization of chargeable item
classes (chapter Managing and Maintaining SAP CC in the Application Help and chapter About the
consumption item mapping in the Core Tool primary Help).

After the Task | Inthe Core Tool user interface, open the consumption item class mapping, and check that it is valid.
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6.2 Post Phase 1 - Checklist

This phase lists the checks and actions to be performed after phase 1 is successfully completed.
In SAP Convergent Charging, check that all the chargeable item classes of SAP Convergent Charging are related in the

consumption item mapping.
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7 Procedure - Phase 2

7.1  Step 7-SAPCC

SAP Convergent Charging executes this step.

Enable the Loading of Consumption Items into SAP CI

When When all the chargeable item classes are synchronized.

Note: Because this step requires restarting the instances, it is strongly recommended to execute this
step when the workload of the instances is the lowest.

Who Administrator

How Setup Tool

Before the N/A

Task

Task Enable SAP Convergent Charging to output chargeable items in files and load these chargeable items

as consumption items to SAP Convergent Invoicing.

Note: During this step, you make a backup of the CIF configuration that the procedure of recovery
(section 6.3) can reuse later.

Step 1. Backup the CIF configuration of the Rater instances into a file.
a) Execute the command with the Setup Tool user interface:

setup cif export rater
<INST DIR>/config/cif.rater.config.bck.xml

b) Enter your login and your password.

Note: Check that the file ‘<INST_DIR>/cif.rater.config.bck.xml’ exists, it can be opened in a
text editor, and it is not empty.
2. Export the CIF configuration of the rater instances in a file.
a) Execute the command with Setup Tool:
setup cif export rater
<INST DIR>/config/cif.rater.config.old.xml
b) Enter your login and your password.
3. Copy the file “<REPO_DIR>/CC_CORE_SERVER/config/sapci/cit_ci/cif.rater.config.xml.sk”, and
paste it with a new name to “<INST_DIR>/config/cif.rater.config.new.xml”.
4. Open the files “<INST_DIR>/config/cif.rater.config.old.xml” and

|n

“<INST_DIR>/config/cif.rater.config.new.xml” in a text editor (an XML editor is recommended).

5. In the file ‘cif.rater.config.new.xml’, replace the XML element
‘<chargedltemTransactionProcessor>’" by the same XML element of the file
“cif.rater.config.old.xml”.

6. Save the file 'cif.rater.config.new.xml'.
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Enable the Loading of Consumption Items into SAP CI

7. Configure the CIF of the rater instances.
a) Execute the command with Setup Tool:

setup cif import rater
<INST DIR>/config/cif.rater.config.new.xml

b) Enter your login and your password.

Note: Check on the console that the CIF configuration is successfully imported.
8. Backup the CIF configuration of the bulkloader instances into a file.

a) Execute the command with Setup Tool:

setup cif export bulkLoader
<INST DIR>/config/cif.bulkloader.config.bck.xml

a) Enter your login and your password.

Note: Check that the file ‘<INST_DIR>/cif.bulkloader.config.bck.xml’ exists, it can be opened
in a text editor, and it is not empty.

9. Export the CIF configuration of the bulkloader instances to a file.
a) Execute the command with Setup Tool:

setup cif export bulkLoader
<INST DIR>/config/cif.bulkloader.config.old.xml

b) Enter your login and your password.

10. Copy the file
'<REPO_DIR>/CC_CORE_SERVER/config/sapci/cit_ci/cif.bulkloader.config.xml.sk' to the file
'<INST_DIR>/config/' and rename it '<INST_DIR>/config/cif.bulkloader.config.new.xml'

11. Open the files '<INST_DIR>/config/cif.bulkloader.config.old.xml' and
'<INST_DIR>/config/cif.bulkloader.config.new.xml' in a text editor (an XML editor is
recommended).

12. In the file ‘cif.bulkloader.config.new.xml', replace the ‘<bulkReader>" XML elements whose
attribute ‘adminParameterPrefixName’ is ‘POSTPAID_CIT_READER’ or ‘PREPAID_CIT_READER’ by
their equivalent nested XML elements located in the 'chargedltemSequence' XML element of the
file 'cif.bulkloader.config.old.xml'.

13. Save the file 'cif.bulkloader.config.new.xml'.
14. Configure the CIF of the bulkloader instances.
a) Execute the command with Setup Tool:

setup cif import bulkloader
<INST DIR>/config/cif.bulkloader.config.new.xml

b) Enter your login and your password.
Note: Check on the console that the CIF configuration is successfully imported.

15. Apply the configuration by restarting the Bulkloader instances, and then the rater instances.

After the Task | N/A
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7.2 Post Phase 2 - Checklist

This section describes the checks and actions to be performed after phase 2 is successfully completed.
Charge a daily CDR batch and check that:
e Chargeable items generated by SAP Convergent Charging are loaded into SAP Convergent Invoicing as consumption items.

e The directories ‘SAPCC_CI/ACQUIRED/COM_EXCEPTION’ and ‘SAPCC_CI/ACQUIRED/INVALID’ of the working directories of
the bulkloader instances are empty; otherwise, determine why the chargeable items cannot be loaded to SAP Convergent
Invoicing, fix the issue, and then check this step again.

e Read carefully the recommendation listed in section 7.1.

If the check fails and the system is blocked, undo the configuration, and then apply the step described in section 6.3. Investigate
in the logs/traces of SAP Convergent Charging and SAP Convergent Invoicing to figure out the issues, and then fix them before
restarting this phase.

When the consumption items are successfully loaded into SAP Convergent Invoicing, the transition phase can start. This means
the end of phase 2.

Important: Plan to execute phase 3 at least one rerating retention period later. Section 9.3 describes the procedure for
retrieving the rerating retention period of SAP Convergent Charging.

7.3 Error Management

SAP Convergent Charging executes this step.

If phase 2 cannot be completed, apply the following step to undo the changes of phase 2:

Deactivate the Loading of Consumption Items

When If the post-procedure fails.

Note: Because this step requires restarting the instances, it is strongly recommended to execute this
step when the workload of the instances is the lowest.

Who SAP Convergent Charging

How Setup Tool

Before the N/A

Task

Task Deactivate the output of the chargeable items in files and the loading of these chargeable items as

consumption items to SAP Convergent Invoicing.

Step 1. Undo the CIF configuration change of the rater instances.
a) Execute the command with the Setup Tool user interface:

setup cif import rater
<INST DIR>/config/cif.rater.config.bck.xml

b) Enter your login and your password.

Note: Check on the console that the CIF configuration is successfully imported.

2. Undo the CIF configuration of the bulkloader instances.
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Deactivate the Loading of Consumption Items

a) Execute the command with Setup Tool:

setup cif import bulkloader
<INST DIR>/config/cif.bulkloader.config.bck.xml

b) Enter your login and your password.
Note: Check on the console that the CIF configuration is successfully imported.

3. Apply the configuration by restarting the bulkloader instances, and then the rater instances.

After the Task | Check that the system runs in the same way as before beginning this step.
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8

8.

Du

8.

Transition Phase

1  Warning and Recommendation

ring the transition phase:

Do not modify the consumption items in SAP Convergent Invoicing. If some CDRs must be modified, modify the CDRs in
BART. The modified CDRs will be transferred from BART to SAP Convergent Invoicing when the CDRs are charged or
recharged.

Do not delete the consumption items in SAP Convergent Invoicing. If some CDRs must be deleted, for example some CDRs
which are duplicated, delete the CDRs in BART. The CDRs are never deleted from SAP Convergent Invoicing but are ignored
by the rerating process.

Do not consume the Web Service related to the charging process during the transition phase because the CDRs processed
by the Web Service cannot be rerated during the transition phase.

2  Step 8-SAPCI

SAP Convergent Invoicing executes this step.

Customizing for the Transition Phase

When When the consumption items are successfully loaded into SAP Convergent Invoicing.

Who SAP Convergent Invoicing

How SAP GUI > SPRO > IMG

Before the N/A

Task

Task Enable phase 2 by entering a transition start date and the retention period of SAP Convergent

Charging in Customizing for SAP Convergent Invoicing.

Step In Customizing for Contract Accounts Receivable and Payable, choose > Convergent Invoicing >
Integration > Enter Specifications for the Transition of Data Storage.

Set a date for ‘Start of Transition of Data Storage’. If ‘Start of Transition of Data Storage’ is not empty,
and the field ‘Start of Processing of Consumption Items in SAP CI’ is not filled, phase 2 is in process.
This means that during phase 2 the transaction for manipulating consumption items (CWB) is
disabled. Furthermore, no rate triggers and no rerate triggers can be created.

After the Task | Check that the value of the retention period of SAP Convergent Charging (section 9.3) is the same as
in the Customizing entry ‘SAP CC retention period’ in SAP Convergent Invoicing. This number of days
determines the period before an activation of data storage is possible (phase 3).

30
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9 Procedure - Phase 3

You must execute this phase when SAP Convergent Invoicing contains enough consumption items to execute its rerating
process. The number of consumption items is enough after the complete retention period of chargeable items in SAP
Convergent Charging. This is necessary to prevent a rerating operation while more snapshots than consumption items exist in
the system.

After this phase, you will be able to execute and use all the new features related to the consumption items of SAP Convergent
Invoicing, including the high-volume rerating process.

9.1 Checklist of Phase 3

Before starting phase 3, be sure that SAP Convergent Invoicing holds enough consumption items to execute the rerating
process.

9.2  Steps of Phase 3

9.2.1 Step 9 - SAP CC

SAP Convergent Charging executes this step.

Start the Charging\Recharging Web Service

When Before step 10

Note: Because this step requires restarting the instances, it is strongly recommended to execute this
step when the workload of the instances is the lowest.

Who Administrator

How Setup Tool

Before the N/A

Task

Task The goal of this step is to publish the Web service for charging and recharging chargeable items.
Step 1. Export the instance map to afile.

a) Execute the command:

setup instancemap export ./instancemap.csv
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Start the Charging\Recharging Web Service

b) Enter your login and your password at the prompt.

Note: Check on the console that the export is successful and that the file ‘instancemap.csv’
exists.

2. Modify the instance map to enable the Web Service on the dispatcher.
a) Open the file ‘instancemap.csv’ in a text editor.

b) In all the lines that include the column ‘Instanceld' starting with ‘dispatcher’, set the
value of the column ‘WSHost’ and ‘WSPort’ respectively with the address of the
corresponding dispatcher and the port where you want to publish the web service. The
addresses must be visible from SAP Convergent Invoicing.

3. Import the updated instance map.
a) Execute the command:
setup instancemap import ./instancemap.csv -clean
b) Enter your login and your password at the prompt.
Note: Check on the console that the export is successful.

4. Apply the configuration by restarting the dispatcher instances of the SAP CC system.

After the Task | N/A

9.2.2 Step 10 - SAP CI

SAP Convergent Invoicing executes this step.

Create an SAP CC Logical Port for the Web Service Consumer Proxy

When After step 9

Who SAP Convergent Invoicing

How SAP GUI, transaction SOAMANAGER

Before the The relevant Web service consumer proxy must be up-to-date

Task

Task Enable SAP Convergent Invoicing to consume the Web Services of SAP Convergent Charging. The

already updated consumer proxy for the relevant Web service operation needs a logical port. Create
a logical port for your Web service proxy according to the procedure described in the section Setting
Up Communication with SAP Convergent Charging using Web Services of the Integration Guide for
the Offer-to-Cash End-to-End Process Based on SAP Billing and Revenue Innovation Management.

Step N/A

After the Task | Any Web service operation of this Web service must be usable.
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9.2.3 Step 11 - SAP CI

SAP Convergent Invoicing executes this step.

Customizing for Phase 3

When After step 10

Who SAP Convergent Invoicing

How SAP GUI > SPRO > IMG

Before the Check that the CDR retention period is over.

Task

Task Enable phase 3 by entering a ‘Data Storage Active Date’ in Customizing in SAP Convergent Invoicing.
Step After the transition phase is successful, go to Customizing for Contract Accounts Receivable and

Payable and choose Convergent Invoicing > Integration > Enter Specifications for the Transition of
Data Storage.

Set a date for ‘Start of Processing of Consumption Items in SAP CI’. If the date in ‘Start of Transition of
Data Storage’ is older than or equal to the current system date, the field ‘Start of Processing of
Consumption Items in SAP CI' can be changed. If the checks are successful, this means the transition
phase is finished and phase 3 is in process. Furthermore, during phase 3, the transaction for
manipulating consumption items (CWB) works, and the rate and rerate triggers can be created.

After the Task | Check that the rate and rerate triggers are created.

Check that the transaction for manipulating consumption items (CWB) works.

9.24 Step 12 - SAP CC

SAP Convergent Charging executes this step.

Enable SAP CC to support the rerating process of SAP CI

When Just after step 11 has been successfully executed.

Note: Because this step requires restarting the instances, we strongly recommend that you perform
this step when the workload of the SAP Convergent Charging system is the lowest.

Who Administrator

How Config Tool

Before the N/A

Task

Task After this step, SAP Convergent Charging sends rerating requests to SAP Convergent Invoicing but no

longer to BART Server (in SAP Convergent Charging).

PUBLIC
Activation of Consumption Item Management in SAP Convergent Charging and SAP Convergent Invoicing © 2025 SAP SE or an SAP affiliate company. All rights
Procedure - Phase 3 reserved.



Enable SAP CC to support the rerating process of SAP CI

After this step is successful, it will not be possible to undo the modification and enable rerating by
BART again without major issues.

Step 1. If the Admin+ user interface is not yet connected to a dispatcher instance of the SAP CC
system, connect Admin+ with the dispatcher by following the steps defined in section 9.1.

2. Configure SAP Convergent Charging so that it can delegate the rerating process to SAP
Convergent Invoicing.

a) Execute the command:
set EIF EXTERNAL SYSTEM CODE RERATING CI persistent

Note: Check that the value of the EIF_EXTERNAL_SYSTEM_CODE_RERATING now has a
persistent value ‘Cl’ as shown in the following snapshot:

Received from updater#l

- NAME: EIF EXTERNAL SYSTEM CODE RERATING (PERSISTENT,
updater)

- ACCESS: read-write (DB)
- DEFAULT VALUE: None
- PERSISTENT VALUE: CI
3. Apply the configuration:
O Restart the updater instances of the SAP CC system.

O If some instances of the Core Tool are running, they must be restarted to take the
configuration change into account.

After the Task | N/A

9.2.5 Step 13 - SAP CC

SAP Convergent Charging executes this step.

Customizing for Phase 3

When After step 12

Who SAP Convergent Charging

How Database

Before the Determine the retention period for the CDRs stored by BART Server:
Task e The retention period for CDRs must be between 40 and 180 days

e The retention period for CDRs must be equal to the retention period for counter snapshots in
Core Server (see step 14)

Task The goal of this step is to enable the archiving of CDRs in the BART Server database and to configure
the retention period for the CDRs before they are archived.

Step Refer to the chapter Configuration of the BART Database in the SAP CC Configuration Guide.
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Customizing for Phase 3

After the Task | N/A

9.2.6 Step 14 - SAP CC

SAP Convergent Charging executes this step.

Customizing for Phase 3

When After step 13

Who SAP Convergent Charging

How Setup Tool

Before the Determine the new retention period for the counter snapshots stored by Core Server:
Task e The retention period for the counter snapshots must be between 40 and 180 days

e The retention period for the counter snapshots must be equal to the retention period for CDRs
in BART Server (see step 13)

Task The goal of this step is to increase the retention periods for the counter snapshots stored by Core
Server for rerating purposes.

Step 1. Stop the updater and rater instances of the SAP CC system.
2. Increase the number of counter snapshots stored for the rerating of charging contracts:
a) Execute the command with the Setup Tool user interface:

setup migration increaseCounterSnapshotCount
<NEW_SNAPSHOT COUNT>

b) Enter your login and your password at the prompt.

Note: Depending on the number of counter snapshots already present in the Core Server
database, the command may take several hours because the existing counter snapshots
must be reorganized according to the new retention period. If the operation is stopped
before its completion, executing it again will resume it. The operation must be completed
before starting the instances; otherwise, the counter snapshots will be in an inconsistent
state.

3. Start the updater and rater instances of the SAP CC system.

Note: The retention period of consumption items must also be updated to SAP Convergent Invoicing
(except if it is already done at installation time).

After the Task | Update the retention period of the consumption items of SAP Convergent Invoicing accordingly.

9.3 Error Management

As described in step 12, it is not possible to move the rerating process back to BART.
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10 Additional Information

10.1 Connect Admin+ with a Dispatcher Instance of SAP CC

1. Start Admin+.
2. Identify the address of the host on which the dispatcher you want to connect to is running.
a) Execute the command:
a+ > host dispatcherHostName dispatcherListeningPort
Where:
-dispatcherHostName: Is the name of the host machine on which the dispatcher instance is running
-dispatcherListeningPort:|sthe port that the HCl server is listening to

For example, if the dispatcher you want to connect to is listening to the following address: http://1.2.3.4:9060, the
command must be: a+ > host 1.2.3.4 9060

3. Establish the connection with the identified dispatcher by entering the user credential with which you want to be
authenticated by the instance.

a) Execute the command:

a+ > user login password

Where:

- login: Is the login of an SAP CC user whose role is admin
- password: Is the password of the SAP CC user

b) Check that the Admin+ prompt is changed and now contains the dispatcher instance you are connected to. For
example, if the master dispatcher is dispatcher#1, the prompt must be:
[dispatcherHostName]dispatcher#l >

If the prompt is not changed, return to step 2 and check that the specified value is correct.

10.2 Read Version of SAP CC

The version of a running SAP Convergent Charging is an indicator available whatever the instances. For more information about
this indicator, see the System Parameter Reference of SAP Convergent Charging.

To read the version of a running SAP Convergent Charging system, use the following procedure:

1. If Admin+ is not yet connected to a dispatcher instance, connect Admin+ with the dispatcher by following the steps
defined in section 9.1.

2. Get the version of all the instances of SAP Convergent Charging.
a) Execute the command:
a+ > get VERSION
Example of results received by rater#1:

- NAME: VERSION (MEMORY, rater#l)
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- ACCESS: read-only (INDICATOR)

- MEMORY VALUE: 4.5.0.0

Example of results received by dispatcher#1:

- NAME: VERSION (MEMORY, dispatcher#l)
- ACCESS: read-only (INDICATOR)

- MEMORY VALUE: 4.5.0.0

Note: The versions of all the instances are displayed on the console and are the same ones. The version of the running
SAP Convergent Charging is the MEMORY_VALUE (4.5.0.0 in the previous snapshot for SAP Convergent Charging 4.0).

10.3 SAP CC Rerating Retention Period

The rerating retention period is in days and corresponds to the number of counter snapshots kept by SAP Convergent Charging.

The number of counter snapshots is defined in SAP Convergent Charging as an administration parameter and is available via
Admin+ by executing the following procedure:

1. If Admin+ is not yet connected to a dispatcher instance, connect Admin+ with the dispatcher by following the steps
defined in section 9.1.

2. Read the counter snapshot count.
a) Execute the command:
get COUNTER_SNAPSHOT COUNT persistent updater

Note: The next example is a snapshot of the result of the previous command. The counter snapshot count is the
persistent value (40 in this example) meaning that the rerating retention period is 40 days.

Example of results received by updater#1:

- NAME: COUNTER SNAPSHOT COUNT (PERSISTENT, updater)
- ACCESS: read-write (DB)

- DEFAULT VALUE

- MEMORY VALUE: 40

10.4 Consumption Item Class Design

This part deals with the design of consumption item classes that can be synchronized with an existing chargeable item class.

This section is based on the following chargeable item class and describes how to design the consumption item class so that it
can be synchronized later with this chargeable item class:
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Mame Sample Class

rh!' ﬂ

=

Descripkion Class for the sample service

Properties

Marne Cakegory Type Descripkion

O Consumption Dake  |Defaulk Properties Date
O User Identifier Defaulk Properties Skring

O Service Identifier  |Defaulk Properties Skring

operties Mumber  The quantity of service to be charged
QoS Iser Properties String  (The Quality of Service is "HIGH" or "LO%W"
Record Date ser Properties Date  |The date on which the CI was recarded in the syskem

Figure 6: Window of a Chargeable Item Class

10.4.1 Consumption Item Class Field Design

The default fields of a chargeable item class are defined in the basic interface component of a consumption item class as the
following fields:

Chargeable Item Class Default Field Consumption Item Class Basic Interface Component Field

Consumption Date CONSUMDATE
User Identifier ACCESS_USERID
Service Identifier ACCESS_SERVICEID

The user fields of a chargeable item class are the customer fields of a consumption item class.
Create a consumption item class field for each field of the chargeable item class according to the following rules:

e |f the name of the chargeable item class field is a valid consumption item class field, keep the same name. A valid
consumption item class field may contain up to 16 upper-case alphanumerical characters and underscores (_), and it must
start with a letter.

e [f the name of the chargeable item class field is not a valid consumption item class field, choose an arbitrary name for the
consumption item class field, and then create an entry in the table “consumption item class field name, chargeable item

class field name”.
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10.4.2 Consumption Item Class Identifier and Name Determination

The consumption item class identifier is equivalent to the chargeable item class name. They can be synchronized in two ways as
shown in the next figure:

Chargeable ltem m‘m
Class

(1)

’—ikr Consumption
ltem Class
Custom

Mapping 2)

{or}

Figure 7: Synchronization between Chargeable and Consumption Item Classes

Note: A valid consumption item class identifier must have exactly 4 upper-case alphanumerical characters and must not start
with a number (only numerals and Latin alphabet are allowed).

According to Figure 7:

e (1) The name of the chargeable item class is the valid identifier of a consumption item class; in this case, the name of a
consumption item class is similar to the name of the chargeable item class.

e (2) The name of a chargeable item class is not the valid identifier of a consumption item class; in this case, the
consumption item identifier is an arbitrary identifier. The name of a chargeable item class and the identifier of a
consumption item class are synchronized via the custom mapping.

For example, the chargeable item class “Sample Class” is not a valid consumption item class identifier. The consumption
item class identifier will be arbitrarily named “ZSMP”. A custom mapping is required to link ‘Sample Class’ with ‘ZSMP’.

The consumption item class has also a name. The name of the consumption item class can be:
e The name of the chargeable item class if it is not already the identifier of the consumption item class
e The description of the chargeable item class if it exists

e An arbitrary name
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